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PRELIM-2 EXAMINATION 2025-26
SUB: INFORMATION TECHNOLOGY (402)
SET-1
 Class:X                                                                                                                                Time allowed: 2 Hrs
 Date: 02.02.2026   					                                                           Maximum Marks: 50 
General Instructions:
1. Please read the instructions carefully.
2. [bookmark: _GoBack]This Question Paper consists of 21 questions in two sections: Section A & Section B.
3. Section A has Objective type questions whereas Section B contains Subjective type questions.
4. Out of the given (5+16=) 21 questions, a candidate has to answer (5 + 10 =) 15 questions in the   allotted (maximum) time of 2 hours.
5. All questions of a particular section must be attempted in the correct order.
6. SECTION A - OBJECTIVE TYPE QUESTIONS (24 MARKS):
i. This section has 5 questions with internal choices.
ii. Marks allotted are mentioned against each question/part.
iii. There is no negative marking.
iv. Do as per the instructions given.
7. SECTION B – SUBJECTIVE TYPE QUESTIONS (26 MARKS):
i. This section has 16 questions.
ii. A candidate has to do 10 questions.
iii. Do as per the instructions given.
iv. Marks allotted are mentioned against each question/part.
	
SECTION A: OBJECTIVE TYPE QUESTIONS
	      1
	Answer any 4 out of 6 questions from Employability skills

	i
	Which of the following is NOT an element of communication within the communication process cycle? 
a) Channel 
b) Receiver 
c) Sender 
d) Time
	1

	ii
	What makes you complete work or studies without others cheering you? 
(a) Self-confidence 
(b) Communication 
(c) Self-motivation 
(d) Self-esteem
	1

	 iii
	Which program runs automatically as soon as a computer is switched on to perform a self-test? 
(a) Operating System 
(b) BIOS 
(c) File Explorer 
(d) Anti-virus
	1

	        iv
	Ravi’s customer comes to his store and starts shouting at him. He does not get angry. He listens to what his customer is saying. He is ____________. 
(a) hardworking 
(b) confident 
(c) patient 
(d) trying new ideas
	1

	 v
	How many sustainable development goals are given by the United Nations? 
(a) 18 
(b) 17 
(c) 15 
(d) 20
	1


	 vi
	In the SMART method of setting goals, what does the letter ‘M’ stand for? 
(a) Meaningful 
(b) Measurable 
(c) Managed 
(d) Mental
	1

	    2
	Answer any 5 out of 6 questions from Subject Specific Skills
	

	i
	Which database object is a collection of all formatting information that can be saved and then applied to a document? 
(a) Template 
(b) Style 
(c) Frame 
(d) Query 
	1

	ii
	Which feature provides a convenient way to apply a style to scattered objects—such as pages, frames, or tables—at different locations in a document? 
(a) Drag and Drop 
(b) Fill Format 
(c) Style Action 
(d) Formatting Toolbar
	1

	iii
	Which function is used to combine information from multiple sheets into one place to summarize data? 
(a) Goal Seek 
(b) Scenarios 
(c) Consolidate 
(d) Subtotal
	1

	iv
	Which software is specifically used to create, update, and retrieve data from an organized collection of information? 
(a) MS Word 
(b) MS Excel 
(c) DBMS (Database Management System) 
(d) LibreOffice Writer
	1

	v
	How is a "Risk" specifically defined in the context of workplace health and safety? 
(a) Something that has the potential to cause harm to people.
(b) The probability of causing harm to people. 
(c) A written statement of commitment by an employer. 
(d) Freedom from any potential harm or danger.
	1

	vi
	Rahul wants to generate a Table of Contents (ToC) in his LibreOffice Writer document. However, when he inserts the ToC, it appears empty. Which of the following is the MOST likely reason for this issue? 
a) He did not protect the ToC against manual changes 
b) He forgot to apply heading styles (Heading 1, Heading 2, etc.) to his document headings 
c) He placed the cursor at the wrong location before inserting ToC 
d) He did not rename the default title "Table of Contents" to "Contents"
	1

	    3
	Answer any 5 out of 6 questions from Subject Specific Skills
	

	i
	What is the term for a text or image that appears faintly in the background of a page? 
(a) Water mark 
(b) Trademark 
(c) Copyright 
(d) Embossing
	1

	ii
	Which of the following is the default function when using the Consolidate tool? 
(a) Average 
(b) Sum 
(c) Max 
(d) Count
	1

	iii
	What tool is used to predict the output while changing the inputs to explore various alternatives? 
(a) Consolidate 
(b) What-if scenario 
(c) Goal seek 
(d) Find and Replace
	1

	iv
	Which data model is based on the principle of setting relationships between two or more tables using common fields?, 
(a) Hierarchical Data Model 
(b) Relational Data Model 
(c) Network Data Model 
(d) Connection Data Model
	1

	v
	Which category of hazards is primarily present in facilities characterized by repetitive movements and haphazardly set up workstations? 
(a) Physical Hazards 
(b) Biological Hazards 
(c) Ergonomic Hazards 
(d) Chemical Hazards
	1

	vi
	When a spreadsheet is successfully set to "Shared mode" to allow multiple users to collaborate, what specific indicator appears in the title bar? 
(a) (protected)
(b) (collaborate)
(c) (shared)
(d) (multi-user)
	1

	    4
	Answer any 5 out of 6 questions from Subject Specific Skills
	

	i
	Which keyboard shortcut is used to open the Templates dialog box? 
(a) Ctrl + Alt + N 
(b) Shift + Ctrl + N 
(c) Ctrl + Alt + T 
(d) Shift + Alt + T
	1

	ii
	To record a macro, the feature must be enabled from which menu option? 
(a) File > Properties 
(b) Edit > Track Changes 
(c) Tools > Options > LibreOffice > Advanced 
(d) Insert
	1

	iii
	A field that uniquely identifies a row in a table is known as the:
(a) Foreign Key 
(b) Primary Key 
(c) Composite Key 
(d) Alternate Key
	1

	iv
	In which type of relationship does one specific record in a master table correspond to multiple records in a transaction table?
(a) One-to-One 
(b) One-to-Many 
(c) Many-to-Many 
(d) Many-to-One
	1

	v
	What is the recommended eye-level position for a computer monitor to prevent musculoskeletal problems? 
(a) The monitor should be 10 inches below eye level. 
(b) The monitor should be positioned to the far left of the user. 
(c) The top of the monitor should be at eye level. 
(d) The monitor should be at a 45-degree upward tilt
	1

	vi
	Which condition, also known as Repetition Strain Injury (RSI), is characterized by persistent pain in muscles and tendons due to sustained or constrained postures?
(a) Computer Vision Syndrome 
(b) Occupational Overuse Syndrome 
(c) Cardiac Arrest 
(d) Physical Intimidation
	1

	5
	Answer any 5 out of 6 questions from Subject Specific Skills
	

	i
	LibreOffice Writer supports up to how many levels of headings? 
(a) 5 
(b) 10 
(c) 15 
(d) 20
	1

	ii
	Which feature allows multiple users to access and edit the same spreadsheet simultaneously? 
(a) Linking 
(b) Sharing 
(c) Macros 
(d) Consolidating
	1

	iii
	When you save a database in LibreOffice Base, what is the default file extension?
(a) .odt 
(b) .ods 
(c) .odb 
(d) .odp
	1

	iv
	Which database object is defined as a "question asked from a database" to retrieve specific information?
(a) Form 
(b) Table 
(c) Query 
(d) Report
	1

	v
	According to fire safety classifications, which materials fall under "Class A"? 
(a) Wood, cloth, and paper. 
(b) All liquid, grease, and gas materials. 
(c) Electrical materials and equipment.
(d) Volatile materials like magnesium and sodium
	1

	vi
	If a victim of an electrical accident has stopped breathing, which emergency medical procedure might they require? 
(a) Immediate hydration. 
(b) Cardio-Pulmonary Resuscitation (CPR). 
(c) Range of motion exercises. 
(d) Visual acuity testing.
	1



SECTION B: SUBJECTIVE TYPE QUESTIONS
Answer any 3 out of the given 5 questions on employability skills in 20 – 30 words. (2 x3  = 6 marks) 
	Q. 6
	What are the 7 Cs of effective communication?
	2

	Q. 7
	Explain the ‘ABC’ of stress management.
	2

	Q. 8
	What is the purpose of backing up data, and why is it important for organizations?
	2

	Q. 9
	List four key qualities of a successful entrepreneur.
	2

	Q. 10
	Identify three major problems related to sustainable development.
	2



Answer any 4 out of the given 6 questions in 20 – 30 words. (2 x 4 = 8 marks) 
	Q. 11
	Differentiate between 'Inserting' and 'Linking' an image.
	2

	Q. 12
	What is a 'Macro' and why is it used?
	2

	Q. 13
	Scenario: Aisha is a regional manager for a retail chain with two outlets. She maintains the sales records for "Outlet 1" and "Outlet 2" in two different sheets within her LibreOffice Calc spreadsheet. She needs to create a third sheet that provides the total combined sales for both outlets to identify overall trends. Additionally, Aisha has a fixed target profit she wants to achieve next month. She knows the formula for her profit but needs the spreadsheet to calculate the exact input value (the number of items to sell) required to reach that specific "Goal".
Questions:
1. Which specific function should Aisha use to combine and summarize the information from both outlet sheets into her summary sheet? 
2. Which data analysis tool should she use to find the necessary input value based on her specific target profit?
	2

	Q. 14
	Distinguish between Data and Information.
	2

	Q. 15
	Define the terms 'Health', 'Safety', and 'Security' as they relate to a workplace environment.
	2

	Q. 16
	Distinguish between an 'Accident' and an 'Emergency' and provide one example of each in an organizational context.
	2





    Answer any 3 out of the given 5 questions in 50– 80 words each (3x 4 = 12 marks)
	Q. 17
	Anjali is preparing a 60-page research project on "Renewable Energy" using LibreOffice Writer. To ensure her document is professional and easy to navigate, she needs to perform several specialized tasks:
1. She wants to apply a consistent set of formatting (font size 12, Bold, and Left alignment) to all her chapter titles. Instead of manual formatting, she wants to save these settings as a single named group to apply them instantly to other titles.
2. Anjali has inserted a photograph of a solar farm. She wants the project text to flow around the image so that the document looks well-organized and the text rearranges itself if she moves the photo.
3. She needs to create an automated list of all her topics, subtopics, and their page numbers at the beginning of the report. This list should be hyperlinked so she can navigate directly to specific sections.
4. She shares her draft with her supervisor for feedback. She wants to ensure that all edits, comments, and deletions made by the supervisor are recorded so she can review them later

Questions:
1. Which feature of Writer should Anjali use to store and apply the collection of formatting information for her titles? 
2. Which Text Wrapping setting should she apply to the photograph to make the text flow around it? 
3. What is the name of the feature used to generate the automated list of topics and page numbers? 
4. Which powerful tool should be enabled to keep a record of all editing and reviewing done by the supervisor? 
	4

	Q. 18
	Megha is an entrepreneur who sells handmade organic soaps. She has developed a spreadsheet in LibreOffice Calc to calculate her monthly profit based on the Selling Price, Cost of Materials, and Number of Units Sold.
1. Megha wants to prepare for different market conditions. She wants to create three different versions of her budget: one for "Festive Season" (high selling price), one for "Standard Month," and one for a "Clearance Sale" (low selling price). She needs to switch between these sets of values quickly on the same sheet to compare her predicted profits.
2. After reviewing her plans, Megha determines that she must earn a specific target profit of ₹25,000 this month to expand her business. She knows her profit formula but needs the spreadsheet to calculate the exact number of units she must sell to reach that specific target. 
Questions:
1. Which feature of LibreOffice Calc should Megha use to store and compare the "Festive Season," "Standard Month," and "Clearance Sale" alternatives? Define this feature. 
2. Which data analysis tool should Megha use to find the number of units required to reach her ₹25,000 profit goal? Explain how this tool differs from standard calculations.
	4

	Q. 19
	"A database is a collection of objects that work together to manage and represent data." Explain the four primary objects used in a Relational Database Management System (RDBMS) like LibreOffice Base.
	4

	Q. 20
	Ms. Shanti is the librarian at "Green Library." She uses LibreOffice Base to manage book records and member borrowings. At the end of every month, she needs to present a professional summary to the school principal.
1. She needs a feature that presents the data retrieved from her queries in an attractive, understandable, and formatted layout for the principal.
2. She wants the information to be pulled from a combination of her 'Books' table and a 'Fine_Calculation' query.
3. She is worried about data changes. She needs to decide if she wants a report that updates automatically whenever the book records change or one that remains fixed as a historical record.
4. To make the report easier to read, she wants to organize the books by their category (e.g., Fiction, Science, History) rather than just listing them randomly.
Questions:
1. Which specific database object should Ms. Shanti use to create this professional summary? 
2. Can she create this object using both a table and a query simultaneously?
3. What is the name of the report type that updates automatically when the field values in the base table change? 
4. Which feature should she use to organize her data into categories like "Fiction" or "Science"? 
	4

	Q. 21
	An IT firm is reviewing its "Workplace Quality and Safety Manual." Use your knowledge of workplace safety guidelines to answer the following questions:
1.To maintain a healthy ecosystem, an organization analyzes air and water samples. Name the three common forms of analysis used to monitor these pollutants.
2.If a fire breaks out in a storage area containing wood, cloth, and paper, which Class of material does this fall under, and what is its primary characteristic regarding ignition? 
3. "Computer Vision Syndrome" is often caused by poor lighting and glare. State two specific tips to reduce the risk of visual problems while working at a monitor.
4. Why is it strictly recommended that employees remove rings, watches, and necklaces before working on internal computer components? 
	4
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